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RECIPES 
 
Alginate (Sterile Aliquoting) 
(Revised:  June 25, 2007, MX) 
 

To avoid sterile filtering alginate by using syringes, we developed a way to sterilize large quantities of 
alginate at once for later reconstitution. 
 

1. Dissolve alginate powder in MilliQ H2O to 0.5%-1% overnight with continuous stirring. Add 0.5 g 
activated charcoal per gram of alginate, stir for 30 min and then let settle (or spin in 50 mL tubes 
to accelerate).  Sterile filter through Millipore 0.22 µm Express filters.   

2. Transfer sterile alginate solution to 50ml steriflip tube (unscrew the filter membrane, transfer ~45 
mL alginate solution into tube, and then re-screw the filter membrane, which will keep the alginate 
sterile for the following steps).  Freeze down to -20oC (takes 1-2 days). 

3. Lyophilize to dryness- takes ~5 days.  Place the filter in a lyophilization jar in case the sterile filter 
pops (which can happen if the vacuum is turned on too quickly).   

 

Aliquot 
1. Label sterile 1.5 mL tubes with alginate code and number.  Pre-weigh. 
2. Aliquot and transfer dried alginate into tubes in the laminar flow hood by using sterile forceps.  

Promptly aliquot alginate from lyophilizer otherwise alginate will quickly absorb water from air.  
a. Alternatively, remove the filter, and seal alginate within the 50 mL tube with a sterile cap. 

3. Weigh, record difference.  Goal is to have 5-10 mg per tube.   
4. Store at -20oC until use. 

 

Reconstitution 
1. Allow tube to warm to room temperature. 
2. Reconstitute with sterile solution in hood (1X PBS without Ca2+) to desired concentration. 
3. Vortex briefly, then leave on orbital shaker overnight, or until completely dissolved. 
4. Re-vortex tube aggressively then centrifuge briefly before use to remove air bubbles.   

 
Calcium Solution 
 

 50 mM  CaCl2  (2.77 g) 
 140 mM  NaCl   (4.1 g) 
 500 mL MilliQ H2O 

• Measure 500 mL of MilliQ H2O with a graduated cylinder 
• Add CaCl2 and NaCl to the water in a 500 mL beaker 
• Mix with stir bar until thoroughly dissolved 
• Sterile filter with a Millipore Stericup filter, in the hood 
• Label with your name, the date, “Calcium Solution,” and store at room temperature 

 
Fetuin 
(revised: June 25, 2007, MX) 
 

Materials: 
Fetal bovine fetuin 
High-quality MilliQ H2O 
Sterile 50 mL conical tubes 
Clean 1.5 mL microcentrifuge tubes (puncture a hole in the lid with a large gauge needle) 

 

Sterile Aliquoting: 
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• Fully dissolve Fetuin in MilliQ H2O to a concentration of around ~15-20 mg/mL 
• Thoroughly clean dialysis tubing with a large amount of water, and rinse with MilliQ water at 

least 10 times 
• Fill the tubing with Fetuin solution, seal the tubing closed tightly, and dialyze in MilliQ H2O 

(volume ratio=1:50 – 1:100) at 4oC overnight, stirring gently. Replace with fresh MilliQ H2O, and 
dialyze 1-2 more times  

• Measure the Fetuin concentration, using a BCA Protein Assay Reagent Kit 
• Dilute Fetuin solution to desired concentration with MilliQ H2O, usually 10 mg/mL 
• Aliquot Fetuin into 50 mL conical tubes (40 mL/tube) 
• Label tubes and freeze (1-2 days) 
• Lyophilize to dryness (~5 days) 
• Seal lids (place stickers over the holes) and store at -80°C for long-term storage or at -20°C for use 

within 6 months 
 

Producing single aliquots (from 40 mL lyophilized aliquots, or from freshly dialyzed Fetuin) 
• Add MilliQ H2O to each tube to be aliquoted (10 mg/mL) 
• Place conical tube on shaker until fully dissolved 
• Aliquot fetuin into 1.5 mL microcentrifuge tubes (1 mL/tube) 
• Close all of the tubes, and puncture a hole in the lid of each tube 
• Freeze until completely solid (will take a few days at -20°C or overnight at -80°C) 
• Transfer tubes to the lyophilizer as quickly as possible, and avoid letting the tubes thaw during this 

process.  Keep tubes upright: placing tubes in cardboard holders from freezer boxes (cut smaller in 
size to fit in the chambers) will help 

• Lyophilize to dryness (~1 day) 
• Seal the holes in the tops of the lids with stickers, to keep your samples dry 
• Store large amounts of aliquots in the -80°C freezer, but keep a box of tubes in the -20°C freezer 

for immediate use 
 

Reconstituting: 
§ Reconstitute with aMEM to desired concentration 
§ Spin, vortex, and spin down again in centrifuge 

 
 
Follicle Culture Media 
Note:  As with all medias, be sure to use clean glassware that has not been contaminated with harmful 
chemicals.  Rinse all glassware carefully with MilliQ H2O before media preparation to remove any 
bleach, detergent or contaminants. To avoid such issues, you may instead use 50 ml and 15 ml conical 
Falcon tubes. Prepare all media in the hood to keep stock solutions sterile.  Media containing aMEM 
should be wrapped in foil for storage.  Before use, warm Dissection media in a 37°C water bath for at 
least 15 minutes, but Maintenance, Growth, and Maturation medias must be equilibrated in petri dishes in 
the incubator (or in a conical tube with a loosened cap), for at least 30 minutes (aMEM based media 
needs to be kept in a 5% CO2 environment to maintain it’s pH at 7.3 or 7.4).  Media should not be re-used 
after heating; it is best to aliquot the amount you need for the day, and warm it in the incubator/water 
bath, while placing the rest at 4°C for up to one week.  Leftover Growth media may also be used as 
Maintenance media for future experiments.  3mg/mL BSA may be used to replace FBS (for DM and 
MM), but be sure to pH to 7.4 before using. 
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Dissection Media (DM, Dissociation, or L15): 
30 mL  L15 (pre-made, stored at 4°C) 
150 µL  Pen-Strep (pre-made, stored at 4°C) 
300 µL FBS (stock at –20°C; thaw and store at 4°C for up to 2 weeks) 

• Invert gently to mix 
 

Maintenance Media (MM):   
30 mL aMEM (pre-made, stored at 4°C) (add 300 µL L-glutamine if stock doesn’t 

contain GlutaMax) 
  150 µL  Pen-Strep (pre-made, stored at 4°C) 

300 µL FBS (stock at –20°C; thaw and store at 4°C for up to 2 weeks) 
• Invert gently to mix 

 
Growth Media (GM): 

30 mL aMEM (pre-made, stored at 4°C; add 300 µL L-glutamine if stock doesn’t 
contain GlutaMax) 

  30 mg  Fetuin (1 mg/ 1mL, stored at -20°C) 
• Reconstitute with desired amount of media 
• Add to media, rinse tube(s) into media 

30 µL ITS (1 µL/mL of 1000x stock, stored at -20°C, thaw and keep at 4°C for up 
to 2 weeks.  *Be sure to label with your initials and date of thaw*) 

90 mg  BSA (30mg/10mL, stored at 4°C) 
300 mIU rhFSH (final concentration 10mIU/mL)  

• Place on a shaker for 3-5 minutes to ensure all components are mixed 
• Spin down in clinical centrifuge for 3-5 minutes 
• Sterile filter 

 
Maturation Media (MatM): 

9 mL aMEM (pre-made, stored at 4°; add 100 µL L-glutamine if stock doesn’t 
contain GlutaMax) 

1 mL FBS (stock at –20°C; thaw and store at 4°C for up to 2 weeks; 30 mg BSA 
may be used instead, but be sure to pH to 7.4) 

  1 µL  EGF (100 ng/µL stock, 10 ng/mL working) 
  15 µL  hCG (1 IU/µL stock; 1.5 IU/mL working) 
  0.45 uL 10 mIU/mL FSH (optional) 
 
• Place on a shaker for 3-5 minutes to ensure all components are mixed 
• Spin down in clinical centrifuge for 3-5 minutes (1500 RPM) 
• Sterile filter *some prefer to add EGF, hCG, and FSH after filtering 
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FOLLICLE ISOLATION AND CULTURE FOR MICE 
 
Follicular isolation takes about 30-60 minutes per animal (2 ovaries). Encapsulation only takes about 2 
minutes for a few follicles. Plating beads usually takes less than 30 minutes. Image Capture and Analysis 
(day 0) takes up to 2.5 hours depending on yield. 
 
For optimal results, all dissections are done in L15 media (buffered for open air use), on 37°C heated 
stages (temperature control), and on a clean bench (laminar flow hood) to minimize bacterial 
contamination. 
 
Preparation 

1. Prepare all of Dissecting Media (DM), Maintain Media (MM) and Growth Media (GM) 
according to the protocols contained within this handbook.  

2. Place DM into the 37°C water bath (15-30 minutes to warm). 
3. Place MM with loose cap into 5% CO2 incubator for equilibration (30 minutes to warm). 
4. Reconstitute alginate to desired concentration (See “Sterile Aliquoting of Alginate” on pg 3). 
5. Sterilize mesh for Encapsulation (see “Follicle Encapsulation in Alginate” on pg 7). 

  
 

Optional Enzymatic Isolation (best for animals 16+ days) 
Materials for Enzymatic Media (EM): 
DM (pg 4) 
MM (pg 5) 
Collagenase I (Stock: 10% in tubes of 20 µl and 50 µl, 0.1% working) 
Dnase I (Stock: 2% in tubes of 20 µl and 50 µl, 0.02% working) 
 
Procedure: 
1. Thaw Collagenase and Dnase 
2. Combine Collagenase and Dnase with MM to working concentration:  

(20 µL Collagenase + 20 µL Dnase +1900 µL MM)  
(50 µL Collagenase + 50 µL Dnase + 4900 µL MM) 

3. Gently mix the solution and sterile filter it into a new 35 mm dish.  Place in the 
incubator to equilibrate while completing steps 1 and 2 of “Mechanical Follicle 
Isolation” below. 

4. Place ovaries into Enzymatic Media (EM):  cut larger ovaries in half before 
transferring them to EM.  (Transfer ovaries with a wide-bore tip or by holding the 
ovary at the hillus with forceps – be careful to not squeeze the ovary with forceps) 

5. Digest ovaries for 15-20 min (no more than 30 min) in EM in the 37°C, 5% CO2 
incubator (don’t pipette ovaries up and down). 

6. Rinse ovaries in clean DM, and then transfer them to a new dish of DM for 
isolation. 

7. Proceed to follow the Mechanical Follicle Isolation procedure below, continuing 
with step 3. 

 
Mechanical Follicle Isolation 
(See our video on the Oncofertility website: http://oncofertility.northwestern.edu/media/secondary-follicle-isolation) 
(Revised October 2011, JP) 
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1. Euthanize 1 (or more) female(s) (day 12-16 best for follicle isolation), using CO2 asphyxiation or 
isoflurane and a secondary method (cervical dislocation). Remove the ovaries from animal(s). In 
order to assure minimal damage to the ovaries, remove parts of the oviduct and uterus around the 
ovary as well. Place roughly dissected ovaries into a 35 mm dish of DM.  

[Try to keep tissue out of the animal and out of an incubator for less than an hour.  As a 
beginner, start isolating from one animal (2 ovaries) at a time, transferring follicles to MM 
and placing in the incubator before moving on to the next animal.  Use a timer if it helps!  
As you become faster with isolation, you’ll be able to isolate from more animals at a time.] 

2. Under a dissecting scope, release the whole ovaries from uterus, fat pad and bursa by placing one 
pair of forceps at the intersection of the bursa and the oviduct to anchor the reproductive tract in 
place. Then place the second pair of forceps directly next to the first pair but only grip the thin 
membrane of the bursa. Carefully tear the bursa by gently pulling the two pairs of forceps apart, 
exposing the entire ovary. Transfer clean ovaries into a new 35 mm dish containing warm DM by 
grabbing the hillus region with forceps, or by pipetting them up with a wide-bore tip.  Try to not 
squish the ovaries with your forceps. 

 
 

3. Isolate follicles from the first ovary by using two 28g½ Insulin syringes. With one insulin syringe 
in your non-dominant hand, anchor the ovary in your dish while using your dominant hand and 
second syringe to gently tease and “flick” individual follicles from the rest of the ovary. Try to 
remove as much stroma as possible without puncturing the follicle. Dissect out 20-40 secondary 
follicles per ovary (2 layer secondary: 100-130 µm, or multilayer secondary: 150-180 µm). 

4. Add 1 ml MM in the central well, and 3 ml MM in the outer ring of an IVF dish. Transfer intact 
follicles to the outer ring of the IVF dish for a brief rinse and then selectively transfer them (see 
step 6) into the central well, placing no more than 60 follicles in the center of one IVF dish (so 
they won’t all stick back together). Leave this IVF dish inside the incubator at 37ºC, 5% CO2.  

5. Repeat step 1-5 on the remaining ovaries to finish all of the isolation. 
6. After all follicles are in MM (1-2 hr), evaluate under 5x-8x magnification.  Look for healthy 

follicles with the proper amount of granulosa cells; that are in the right size range; with no 
separation between oocyte and granulosa cells; and that have round oocytes.  Some theca cells are 
fine.  Separate “perfect” follicles into the center of your IVF dishes.  This step is THE KEY to a 
good experiment!!  These follicles will be encapsulated – keep multiple IVF dishes so you can 
rotate them in and out of the incubator. 
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Follicle Encapsulation in Alginate (mesh method) 
(See our video on the Oncofertility website: http://oncofertility.northwestern.edu/media/encapsulation-follicles-alginate-
hydrogels) 
 Materials 
 Isolated follicles, stored in MM in incubator (see above) 
 Alginate (pg 3) 
 Calcium Solution (pg 3) 
 MM (pg 5) 
 Polypropylene mesh squares (pg 17) 
 

1. Cut polypropylene mesh into multiple 1” X 1” squares. Cover the mesh squares with 70% EtOH 
for roughly 30 minutes for sterilization, then place them into a clean 100 mm dish to dry within 
the laminar hood (~10 minutes) –OR– place mesh squares under UV light, overnight. 

2. Load a 1mL syringe with your desired concentration of alginate and remove air bubbles.  
3. Fill a 60mm dish about 2/3 of the way with RT calcium solution – set aside.  
4. Create small droplets (~5 µL each) through a 25G needle (1/2 in) onto the nylon mesh inside the 

lid of a 60 mm dish.  Put 5-10 drops per mesh square. 
5. Mouth pipette in an individual granulosa-oocyte complex (GOC) or follicle into each bead, 

transferring as little media as possible. If one group of follicles is transferred at the same time, 
make 1-2 extra alginate drops, and pipette all follicles into the first and then second “wash” drops 
to rinse; then transfer individual follicles into the other drops.  Be sure to clear extra media out of 
your tip between washes, and replace it with a small amount of alginate before pulling follicles 
into your tip (to help eliminate media, and to help avoid air bubbles). 

6. After all “non-wash” beads (0.5% alginate) have a follicle, lift the nylon mesh with forceps and 
turn it upside down over the calcium solution – hold it here for a few seconds. Flick mesh quickly 
to allow all beads to fall into the solution.  Either pipette calcium solution on top of the beads or 
use forceps to push beads below the surface of the calcium solution, to ensure that the entire bead 
is submerged, and to allow for proper cross-linking.  For 1.5% and 3% Alginate, submerge the 
entire mesh containing the alginate beads/follicles right side up into the calcium solution.   

7. Crosslink the beads for the desired time (usually 2 min).  Using forceps, gently transfer beads into 
a dish containing MM  (no more than 20 beads per 35 mm dish).  Keep the beads in the incubator 
until all encapsulation is complete.  

8. Prepare 96-well plates for culture. To minimize the time that the plate spends outside of the 
incubator during imaging, a beginner should only put ~18-20 beads in each plate (1 bead/well).  
Place 100 µL GM in each well to be used, and load surrounding wells with sterile 1X PBS.  Leave 
plates in the incubator for at least 30 min to equilibrate before filling with beads. 

9. Place 1 bead in each well containing GM and culture as desired. 
 
Follicle Encapsulation in Alginate (Min’s alternative method) 
 Materials 
 Isolated follicles, stored in MM in incubator (see “Mechanical Follicle Isolation” pg 6-7) 
 Alginate (pg 3) 
 Calcium Solution (pg 3) 
 DM (pg 5) 
 MM (pg 5) 
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1. Prepare an IVF dish with 4-5 mL of calcium solution in the outer ring, and ~0.5 mL Alginate in 
the center ring (Alginate amount varies on the amount of follicles you have - figure that each 
follicle will require about 5 µL of alginate) 

2. Use your mouth pipette to transfer a few rounds of encapsulations’ worth of follicles (~20) to DM.  
These follicles will be encapsulated within a very small amount of time, but it’s better for them to 
be in DM while outside of the hood instead of MM (it will lose its pH quickly). 

3. Use your mouth pipette to pick up 5 follicles from your dish of DM.  Keep them separated in your 
tip by a small amount of media. 

4. Gently place these follicles across the top of your alginate.  Be careful to keep the follicles 
separated from one another, and work quickly so they won’t fall through the alginate to the bottom 
of the dish  - they’ll be harder to pick up once they stick to the dish. 

5. Using a 10 µL pipette, set to 5 µL, gently fill about half of the tip (~2.5 µL) with alginate, pick up 
one of your follicles, then fill the rest of the tip (~2.5 µL) with more alginate. 

6. Slowly expel the alginate/follicle from the tip (perpendicular over the calcium solution), so it 
hangs like a drop from the end of the tip. 

7. Either tap the hanging drop from the end of your tip, or very gently touch the very bottom of the 
drop to the calcium solution (do not touch your tip to the calcium as the remaining alginate inside 
of it will crosslink, causing it to clog).  

8. Repeat steps 5-7 until all of the follicles in your IVF dish have been encapsulated. 
9. Allow beads to crosslink for 2 minutes, then carefully transfer the beads with forceps to a new 

dish of MM. 
10. Repeat steps 3-9 until all of the follicles from your DM have been encapsulated. 
11. Repeat steps 2-10 until all of your isolated follicles have been encapsulated. 

 
Tips for this method: 

• Try to complete this entire encapsulation while keeping your alginate at RT.  If you leave your 
alginate dish on a heating plate for too long, the PBS in it will evaporate, and cause your alginate 
to become thicker (and then it won’t be 0.5% anymore!).  Keep your follicles in either MM or DM 
at 37°C. 

• Try using the same 10 µL tip for multiple encapsulations – the only times you might need to 
switch to a new tip is when follicles start sticking to the alginate that remains on the outside of the 
tip; or if you dunk the tip in calcium solution, it may become clogged. 

 
Follicle Encapsulation in Fibrin-Alginate IPN 
Ariella Shikanov, Jan. 2009 
 

Materials 
Fibrinogen solution 50 mg/ml, aliquots of 200 µl, stored at -20°C 
Thrombin solution 500 mg(IU)/ml aliquots of 100 µl, stored at -20°C  
Alginate (ALG) solution 0.5%, or lower 
TBS +Ca2+ 50 mM (sterile filter before using) 
Glass slides with spacers and parafilm sprayed with 70% ethanol and dried in the hood 
Isolated follicles, stored in MM in incubator (see “Mechanical Follicle Isolation” pg 6-7) 
 

Procedure 
1. Thaw Fibrinogen and Thrombin solutions. 
2. Pipette the Thrombin solution up and down to mix it well and then dilute it 10-fold with TBS to 

obtain a concentration of 50 mg/ml. 
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3. After follicle isolation is complete, in a sterile tube, mix fibrinogen solution (50 mg/ml) and ALG 
0.5% solution in a 1:1 ratio. Caution! Pipette fibrinogen solution very carefully to avoid forming 
bubbles. After the two solutions are combined, carefully pipette up and down several times (the 
mixture will turn from a clear to a milky solution), or vortex for a few seconds and then spin 
down. 

4. Spot 7.5 µl drops of the Fibrinogen/ALG mixture on the parafilm coated glass slide (you can form 
up to 18 drops on 1 slide. The drops dry out pretty quickly, so for first-timers, start off with 5-6 
drops at a time). To each drop, transfer 1 (or more) follicle(s) in a minimal amount of media 
(alternatively, you can “wash” the follicle in an additional drop of the mixture prior to final 
transfer). 

5. Add 7.5 µl of Thrombin 50 mg/ml solution to each drop. Do not touch the follicle with the drop 
and do not mix. You don’t need to worry about the follicle sinking to the bottom. 

6. Cover the drops with the second parafilm coated glass slide, put in a 100 mm dish upside down 
and transfer to the incubator for 5 min. 

7. Transfer the beads to the Maintenance Media. The beads are sticky but not fragile, so transfer the 
beads by using tweezers. 

 
Alternatively (according to Min Xu): 

Mix fibrinogen, 0.5% alginate, and 1x PBS in a 1:1:2 ration.  After transferring a follicle to the 
fibrinogen/ALG drop, Min sucks up the bead in a pipette tip and expels it into a petri dish containing 50 
mg/ml Thrombin solution. The crosslinking time is approximately 2 min or more (but not longer then 10 
min).  
 
 
Media Change (every other day) 

1. Aliquot the desired GM into a dish (50 µL/well), equilibrate it in the incubator until it is warm. 
2. Image follicles (see “Follicle Image Collection” pg 9) 
3. Using a multichannel pipette, carefully remove 50µl GM from each well and save (in a U-bottom 

96 well plate, covered with a PCR plate sealer) at –80ºC for future analysis. Add 50µl l pre-
equilibrated GM into each well.  

4. Do not keep plates out of incubator for more than 10 minutes at a time. 
 

Imaging and Post-Culture Procedures 
 
Follicle Image Collection 
(Specific to Woodruff Lab imaging system: Leica Application Suite Version 3.6.0[Build:488] ) 
(Revised October 2011, JP) 

• Turn on Camera, Microscope Light Source and Heating Plate 
• Set the microscope filter to match the objective you will be using (ex: HMC 20 for the Hoffman 

20x objective) 
• Open the Leica Application Suite imaging program 
• Click on the [Browse] tab and set up the folder that you would like your images saved to. Be sure 

to set your capture location by highlighting the desired folder you would like your images to be 
saved to then pressing the [Set Capture Location] button. 
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• Click on the [Aquire] tab. This is where you will be able to view the live images and take pictures. 
• Place 96-well plate on the stage, using the 20x HMC objective to locate your follicles. Using the 

coarse and fine focus knobs bring the follicle into focus then switch to the 4x HMC objective. 
• Pay particular attention to focusing on the follicle’s basement membrane. 
• Press [Aquire Image] to take a picture. Images will automatically save to the folder that you 

initially set them to be stored to.  
Note: Imaging should be completed as quickly as possible so that the time that follicles spend out of the 
incubator is kept to a minimum. This will reduce the chances that follicle health is affected by changes in 
media, pH, and temperature. If available, use of a warming stage set at 37°C is beneficial.  
By taking pictures of 1-2 rows at a time then rotating to the next plate, you can avoid plates spending too 
much time outside of the incubator. Keep any plate(s) not being imaged in the incubator.   
 
Measuring Follicle Diameter 

• Open ImageJ (http://rsbweb.nih.gov/ij/) 
 
Set your scale: 

By a micrometer picture: 
• Open your micrometer picture (taken at the same magnification as your pictures to be analyzed), 

by clicking File_Open and then by selecting the picture 
• Click on the “Straight Line Selection” tool (which is the 5th tool from the left on the ImageJ tool 

bar) 
 

 
 

 
 
 
 

• Draw a line on the picture, measuring a known distance 
• While the line is still hi-lighted, click Analyze_SetScale... 
• The “Set Scale” window will open.  In this window, change the “Known Distance” field to the 

distance that you just measured with the straight line tool, and also change the “Unit of Length” to 
the corresponding unit.  Be sure to click the “Global” box, to ensure that every picture you open 
while ImageJ is open will be measured with this scale. Note:  Once you close ImageJ, you will 
have to re-set the Scale every time you re-open it. 
 
By Pixels: 

• Click Analyze_SetScale 
• Set the “Distance in Pixels” and “Known Distance,” following the guide below, according to the 

magnification used to image your follicles:   
§ 20X  208.2 pixels = 100 µm 
§ 10X  104.1 pixels = 100 µm  
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§  5X  52.0 pixels = 100 µm 
 
Customize Outputs: 

• Click Analyze > Set Measurements 
• Select “Display Label,” so your image titles will appear in the measurement window 
• Un-select any unnecessary measurements 

 
Measure Follicles: 

• To open images, go to File > Import_> Image Sequence... 
• Locate and open the proper folder, select the first image in the folder, and click “Open” 
• The “Sequence Options” window will open – Select “OK” 
• A window should then open containing all images within the folder.  You can move between 

images using the scroll bar at the bottom, or by using the “<” and “>” keys on the keyboard 
• Select the line tool (circled on pg 9) 
• Draw a line across the widest diameter of the follicle 
• Hit “m” to record the length of the line 
• Draw a second line across the diameter of the follicle, perpendicular to the first line 
• Hit “m” to record this length 
• Lengths are recorded to the “Results” window  
• When all measurements are complete, transfer values to excel by either: 

o Clicking Edit > Copy All in the “Results” window, and pasting the results into excel 
o Clicking File >_Save As, and saving it as a “.xls” file 

 
Isolating Follicles from Alginate Beads 
Revised, SK 10/2009 
 
Materials: 
 Alginate Lyase 10 IU/mL 
 DM or MM (pg 5) 
 
Procedure: 

1. Prepare alginate lyase solution (LS): 
a. Add alginate lyase to media (10IU lyase/mL of media), pipette up and down a few times to 

mix, or invert.  Allow LS to warm in incubator (MM based) or in a water bath (DM based) 
prior to use (for terminal procedures, dilute Lyase in DM: when continuing with cultures, 
dilute in MM).  To lyase beads in the 96-well plate, prepare 100 µL LS per well.  To lyase 
beads together in an IVF dish, prepare 1mL LS per 15 follicles (1 dish).   

2. Remove all media from wells containing beads, and add 100µl LS to each well.    
a. Alternatively, remove 50 µL of media from the wells (to freeze for media analysis), and 

use a blunt-tip or wide-bore tip to transfer the bead and remaining 50 µL of media from the 
wells to be lyased to an IVF dish.  Remove media from the IVF dish, and replace with 1 
mL LS. 

3. Incubate beads in LS on warming plate (DM-LS) or in the incubator (MM-LS) for 25-30 minutes. 
4. Use a mouth pipette to remove follicles from plates (bend tip to gain access to small wells). 

 
 



Follicle Handbook  Protocol 
 

13  
 

In Vitro Oocyte Maturation  
Revised, SB 5/2008 
 
Materials: 
 DM (pg 5) 
 MatM (pg 5) 
 Hyaluronidase 
 FHM, L15, or KSOM 
Procedure: 

1. Remove follicles from Alginate beads (see “Isolating follicles from alginate beads” on pg 10) 
2. Prepare one IVF dish; add 3mL DM to the outer ring, and 1 mL to the inner ring.  Transfer 

follicles from alginate beads (Step 4 “Isolating follicles from alginate beads”) to the outer ring of 
your IVF dish, then to the inner ring (washing the follicles). 

3. Prepare one IVF dish; which has 3 mL MatM) in the outer ring and 1 mL in the inner ring.  
(optional: cover inner ring with 200 µL of oil) 

5. Wash the follicles in MatM in the outer ring, and then transfer them into the inner ring. For large 
follicles, use a needle to nick the follicle to allow access of media to the COC. (Important step 
for non-antral follicles.) 

6. Incubate (37°C, 5% CO2) for 15-16 hours (although it could take up to 20 hours) 
7. To remove cumulus cells, add 10µl Hyaluronidase stock solution (final con. 0.3%); incubate 

(37°C, 5% CO2) for 2-3mins. Mouth pipette to free oocytes from follicle. (This step is NOT 
necessary if you are going to fix the oocytes immediately, or are preparing for IVF.  Use 
hyaluronidase if you are only imaging oocytes or grading rate of MII in your oocytes.) 

8. Transfer oocytes to FHM, L15, or KSOM solution, and then examine oocyte stage (GV, MI, MII 
or Degenerated) 

 
Fixation of Follicle/Alginate: 4% Paraformaldehyde (PFA)-Cacodylate-Ca2+ Fixation 
(Revised Aug 28, 2006, MX) 
 
Stock Solutions: 
1. Reagent A (0.4 M Sodium Cacodylate Stock, pH=7.3-7.4): 

C2H6AsO2Na×3H2O             8.56 g 
Deionized H2O                                                  100 ml 
Adjust pH=7.3~7.4 with 1N HCl, store at room temperature.  

2. Reagent B (1M Sucrose): 
Sucrose                 3.423 g     
H2O                      10 ml 
Filter through 0.22µm, store at 4°C up to 1 month. 

3. Reagent C (2M CaCl2)  
CaCl2 (anhydrous) 2.22 g 
H2O                        10 ml 
Filter through 0.22 µm, store at room temperature. 

 
Working Solution: 
1.   4%PFA-Cacodylate-Ca2+ Fixation Buffer (4% PFA, 0.1M Sodium Cacodylate, 0.1M Sucrose, 

10mM CaCl2, pH=7.4) 
a. Weigh 1 g of PFA, add into 15 ml of ddH20, add 1-2 drops 1M NaOH 
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-scale this amount up or down depending on how much PFA you need 
b. Heat to 60°C and stir.  Make sure not to go above 60°C as PFA breaks down into different 

components above that temperature.   You will need to heat for about 20-30 minutes depending on 
how much PFA you are planning to make.  

c. After dissolving, turn the heat off, but continue to stir and let the solution cool to room 
temperature. 

d. Add 6.25 ml Reagent A, 2.5 ml Reagent B, 0.2 5ml Reagent C, mixture them and adjust pH=7.4. 
Then fill up to 25 mL with dH2O in 50ml Falcon tube.  

e. Filter through a 0.22 µm syringe and use promptly.  You can store Fixation Buffer at 4°C for up to 
24 hours and use it again (re-filter prior to use).  Otherwise throw it out and make fresh.  The 
fresher the material, the better fixative it will be (especially for the ovary) 

 
Fixation Procedure: 

1. Remove all of culture media carefully, and add 100 µl 50mM CaCl2/140mM NaCl to cross-link 
the alginate again for 2-3mins.  

2. Usually, the bead will become more solid. Carefully take it out of the well by using Dumont 
forceps (type 7b, curved). Try your best not to squeeze the bead; otherwise it could destroy the 
antral follicle integrity.  

3. Drop bead directly into 4%P FA-cacodylate-CaCl2 fixation solution. Up to 20 beads can be put 
into 4mL fixation solution in a 5mL tube. 

4. Lay down the tube and fix follicle for 4 hrs in 4 degree. Gently turn the tube up down every half 
hour. (Note: Four hours fixation is enough. I haven’t tried a shorter fixation time; it may also be 
ok.) 

5. Try to remove all of fixation solution carefully, without sucking the bead into tip. (A small amount 
of fixation solution can be left inside of tube if it is too hard to remove it all.) 

6. Add 4 mL 1XPBS, and gently invert the tube a couple of times, then remove it quickly. 
7. Repeat step 6.   
8. Lightly dye the beads blue, to aid in post-fixation procedures (you’ll be able to see the bead in the 

paraffin block).   
a. Add 0.5%Alcian Blue/0.25% HAc stain solution; stain the bead inside for around 15 

seconds, then take dye solution out ASAP.  (Don’t leave the beads in dye solution for more 
than 1 minute: you DON’T want to stain the follicle!)(Stain solution can be reused) 

9. Repeat steps 6 and 7 
10. Ethanol Dehydration: 

a. 50% EtOH for 10 min, repeat 
b. 60% EtOH for 10 min, repeat 
c. 70% EtOH for 10 min, repeat 
d. The tissue can sit in 70% EtOH at 4°C. 

11. However, do not let tissue sit in 70% EtOH for more than 2-3 days before processing. 
 
*Alternatively, one may lyase beads (see “Isolating follicles from alginate beads” pg 11), and fix follicles 
in 1 mL of 4% PFA or Bouin’s solution.  Once fixed, briefly rinse follicles in PBS to remove excess fix, 
and then re-encapsulate all of the follicles in one group into one alginate bead (see “Follicle Encapsulation 
in Alginate” pg 7 or the alternative method on pg 8).  It’s best to also dye these beads with alcian blue, as 
described above, before transferring them straight to 70% ETOH. 
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Follicle Culture Certification 
 
Getting Started 
Lab members new to the follicle culture system must pass through a series of steps before becoming 
“certified” to culture follicles for experiments.  Different steps will be easier or harder for every person.  
There is no set timeframe for how long this entire process will take, but we’ve found that a person with 
limited experience may pass through these steps and continue on to their own experiments within about 3 
months (3 additional months may be required for the optional exercises).  Don’t get stressed, ask as many 
questions as you can, and use your resources wisely!  We have videos, protocols, and many lab members 
who already use this system that can help you out.   
 
Objectives are loosely separated into different tiers, by degree of difficulty (with a large jump from Tier 3 
to 4), but may be completed in any order.  Please have a trained lab member (preferably your teacher, or 
Min) sign off after you have demonstrated your accomplishments to them.  *These tasks are not to be 
completed as you are being taught, but instead as if YOU are the one teaching them – please be confident 
in your skill set before asking to check off the box you are working on.*  
 
This sheet, along with your prepared packet must be presented to Teresa and Lonnie for review before 
initiating solo experiments. 
 
TIER 1  

¨ Gain access to the animal facility (the following 4 steps must be completed in order) 
o Complete online animal training 
o Complete Occupational Health Paperwork (and receive confirmation of clearance) 
o Assist in adding yourself to a Woodruff or Shea ACUC protocol 
o Complete the User Orientation Training course 
o For work with NHP or Human Tissue, please see Sarah K for additional safety and 

regulatory training information 
¨ Demonstrate proper euthanasia methods 
¨ Locate and remove intact ovaries of a pre-pubertal mouse 
¨ Separate intact ovaries from the rest of the reproductive tract 

 
TIER 2 

¨ Assemble your own mouth pipette 
¨ Prepare medias 

o Demonstrate sterile technique 
o Locate reagents 
o Demonstrate proper handling of common stocks such as FSH, ITS, alginate, EGF, HCG 

(how to thaw, label, store, where to store, etc). 
o Understand the requirements of properly labeling common and personal reagents (Name, 

Date of thaw), dispose of items when they expire  
¨ Understand the basic principles of cell culture: 

o How is the pH of media maintained? 
o Which medias need CO2, which ones do not? 
o What environmental factors could cause damage to follicles and gametes?  How should 

you avoid them?  
¨ Isolate 20 follicles (of any size) from 1 ovary 
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¨ Transfer 90% of isolated follicles from 1 dish to another, or from one drop to another via mouth 
pipette, losing less than 30% of starting follicles after 5 transfers.  

¨ Encapsulate 50% of isolated follicles in alginate 
¨ Demonstrate ability to identify freshly isolated follicles of different sizes with or without the use 

of an eyepiece micrometer 
 
TIER 3 

¨ Isolate 15 follicles of 1 size class from 1 ovary (choose the size class that you will most likely start 
using for your experiments) 

o 80-100 µm 
o 110-130 µm 
o 150-180 µm 

¨ Encapsulate 80% of isolated follicles in alginate 
¨ Image encapsulated follicles 

o Demonstrate competency with microscopy equipment (Leica DM IRB / Spot Advanced 
software) 

§ Understand which lenses and filters to use in different situations 
o Capture clear images, with the proper amount of background 
o Demonstrate ability to image 12 wells within 10 minutes 

¨ Demonstrate ability to properly use ImageJ (to measure follicle and oocyte diameter) 
¨ Demonstrate ability to change media using multi-channel pipette with no more than a 5% rate of 

follicle loss 
 
TIER 4 

¨ Grow 40 follicles (150-180 µm) in culture for 8-9 days with >60% survival, and >40% antrum 
rate.  

o Fix follicles in alginate beads on day 8-9 
o Demonstrate knowledge of post-fixation processes and procedures to follow with the 

Histology core 
o Demonstrate ability to use Nikon Eclipse E600 microscope for imaging of sectioned, H&E 

stained follicles 
¨ Grow 40 follicles (150-180 µm) in culture for 8-9 days with >60% survival 

o Lyase beads on day 8-9, and fix follicles separately (re-encapsulate follicles all in one bead 
for post-fixation procedures) 

¨ Grow 40 follicles (150-180 µm) in culture for 8-9 days with >60% survival 
o Lyase beads, and perform IVM on day 8-9 (follicles should be >300 µm on day 8-9) 
o Recover 80% of the oocytes after IVM (regardless of their stages)  
o Demonstrate ability to distinguish MII, MI, GV and degenerated eggs (Optional) 
o Demonstrate >50% MII egg / survival follicle (Optional) 

¨ Create % Survival Charts, and Growth Charts for 3 successful cultures (as signed off on above) 
o Demonstrate ability to use graphing software (such as Prism) 

 
CERTIFICATION 

• Prepare your package for review: 
• 3 Survival Charts (show them separately or on one graph) 
• 3 Growth Charts (show them separately or on one graph) 
• Bright field images of 1 follicle from multiple days in culture (d2, 4, 6, 8, 10) 
• One quality image of an H&E stained follicle from d8-9 of culture 
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• Any additional items you would like to include 
• Meet with Teresa and Lonnie to discuss your certification 

• Bring this sheet (all items must be signed off on) 
 

Reagents/Supplies 
 
Animals 
 
The Woodruff lab uses CD1 mice for all follicle studies.  Litters are sacrificed down to 12 pups before 
their 4th day of life, to cut down on nutritional variability between litters.  These animals are housed in a 
temperature- and light-controlled environment (14L:10D) and are provided with food and water ad 
libidum.  They are fed Teklad Global irradiated 2919 chow, which does not contain soybean or alfalfa 
meal and contains minimal phytoestrogens.  Animals are treated in accord with the National Institutes of 
Health Guide for the Care and Use of Laboratory Animals and the established Institutional Animal Care 
and Use Committee protocol at Northwestern University. 
 
Follicle Culture Equipment/Supplies 
 

Description Company Product # Notes 
0.22 um Millipore filters Millipore SLGP033RB  
1.7 mL microcentrifuge 
tube 

Axygen 311-04-051  

50 mL Steriflip tube Millipore SCGP00525  
Conical Tubes, 15 mL BD 352096  
Conical Tubes, 50 mL BD 352070  
Culture plate, 96-well Corning 3599  
Dish, Culture, 100 mm BD 353003  
Dish, Culture, 35 mm BD 353001  
Dish, Culture, 60 mm BD 353002  
Dish, IVF BD 353037  
Dissection Microscope 
(1) 

Nikon SMZ1500 with 
Binocular Eyepiece 
Tube for Diascopic 

Darkfield Use 

Use with a heated stage 

Dissection Microscope 
(2) 

Leica S8 APO with Leica TL 
BFDF  

Use with a heated stage 

Dumont #3c Forceps – 
Inox 

Fine Science Tools 11231-20  

Dumont #7b Forceps – 
Inox Medical (curved) 

Fine Science Tools 11270-20  

Forma Laminar Airflow 
Workstation 

Thermo Scientific 1828  

Heated Stage for 
dissection scope 

W. Nuhsbaum, Inc STGWS2000L Ask your local 
microscope supplier for 

a similar item 
Heracell 150i CO2 
Incubator 

Thermo Scientific   
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HSW Norm-Ject 
Syringes, Air-Tite, with 
Leur-Lock Tip 

VWR 80076-428 Rubberless and free of 
silicone lubricants 

Image J NIH http://rsbweb.nih.gov/ij/  
Insulin Syringe, 28G1/2 BD 329410  
Inverted Microscope Leica DM IRB Use with a heated stage, 

ask your local supplier 
Iris Scissors – Delicate 
Straight 10.5cm 

Fine Science Tools 14060-10  

Leica Application Suite  
Version 3.6.0 
[Build:488] 

Leica Microsystems http://www.leica-
microsystems.com 

Version 3.6.0 
[Build:488] 

Needle, 25G BD 305122  
Premiere Slide Warmer Premiere XH-2001  
Spot Advanced Diagnostic Instruments Spot Advanced  
SPOT Insight 2MP 
Firewire Color Mosaic 

Diagnostic Instruments IN1820 Camera for inverted 
microscope 

Surgical Scissors – 
Straight 14.5cm 

Fine Science Tools 14002-14  

Syringe, 1mL BD 309602  
 
Follicle Culture Reagent Info* 
 

Description Company Catalog No. Lot No. 
Activated Charcoal Fisher 05-690A  
Albumin Bovine (BSA) MP Biomedicals 103700 S856J 
Alcian Blue Sigma-Aldrich 05500  
Alginate Lyase Sigma A1603  
Alginate** NovaMatrix 4200101  
Ascorbic Acid Sigma A4403  
BCA Protein Assay Reagent Kit Pierce 23227  
Bouin’s Solution Ricca Chemical 

Company 
1120-32  

C2H6AsO2Na. 3H2O Sigma C-0250  
CaCl2 Wako 039-00475 SDF0564 
Collagenase Worthington 

Biochemical 
CLS-1  

Dialysis Tubing Spectra/Pro 132116, MWCO 8000  
DNase Sigma D4138  
Dulbecco’s Phosphate Buffered Saline 
without Calcium Chloride & 
Magnesium Chloride, 1X  

Gibco 14190  

EGF Sigma A412  
FBS Gibco 10082-139  
Fetal Bovine Fetuin Sigma F-3385 094K7695 
FHM w/out BSA (add BSA before use) Chemicon MR-122-D  
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***Fibrinogen Baxter/ 
Haemacure 
Corporation 

1500952  

****FSH Stock (gifted) Alternative (Sigma 
F4021) 

 

HAc Fisher A38-212  
hCG Sigma CG-5  
HCl Fisher A38-212  
Hyaluronidase Sigma A1603  
ITS Sigma I1884-1VL 076K8913 
KSOM w/ D-Glucose Chemicon MR-106-D  
L-15 Gibco 11415  
NaCl Wako 191-01665 8497 
Pen-Strep Cellgro 30-002-CI 30002105 
PFA Fisher T353-500  
Polypropylene Mesh McMaster Carr 9275T21  
Sucrose Sigma S-1888  
Thrombin (Bovine) Sigma T-4648  
aMEM w/ Glutamax Gibco 32561  
* Unless mentioned specially, all of reagents and media used should be at least cell-culture test, and embryo-tested grade is 
preferred. 
** The alginate we are recommending for the culture system is from NovaMatrix, and it is PRONOVA UP MVG (#4200101). 
The company produces a range of alginates, which are given in the following link 
(http://www.novamatrix.biz/Portals/novamatrix/Content/Docs/ProductDocs/alginate_General_info.pdf).  There are approved 
medical devices currently marketed that contain our alginates and many more in clinical development.  The cited alginate is the 
closest to the alginate used in the majority of our published studies. We have cultured follicles in this alginate and found that 
they do grow well, but the percentages do not correlate exactly with the mechanical properties.  In other words, while we often 
use a 0.25% solution of our alginate to create a permissive environment for follicles, the percentage of alginate to create this 
same mechanical environment using the new alginate is ~0.15%. We notes that their MVG alginate is a low endotoxin alginate, 
high G/M raitio that can be made in a range of molecular weights. They have established safety and toxicity data on these 
purified alginates and have filed drug master and device master files with the FDA to support drug and device filings by our 
partners and customers. 
 
***Gifted: Fibrin Sealant Kit(Hemaseel APR Kit from Haemacure Corp), Fibrinogen from Calbiochem (500gm) Cat#341578 
is also another option.  
****Sereno, recombinant hFSH 
 
Mouth Pipette Construction 
**Mouth pipetting should only be used when using mouse tissue. If you plan on using non-rodent 
tissue (i.e. non-human primate, bovine, human, etc.), mouth pipetting is NOT allowed. In this case, 
a stripper pipette and tips should be used (Cat. # MXL3-STR). This is to protect the tissue from the 
user and to protect the user from any fecal/ intestinal bacterial contamination, infectious diseases, 
and blood borne pathogens. 

Description Company Product # Notes 
0.2 um Syringe Filter Nalgene 180-1320  

Aspirator tube assemblies 
for calibrated 
microcapillary pipettes 

Sigma-Aldrich A5177-5EA  

Glass Pipette VWR 14672-200 5 ¾ inch flint glass  
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MILLEX GP filter unit 
0.22 um 

MILLIPORE SLGP033RB  

Rubber Bulb 1mL Fisher Scientific 03-448-21  
Silicone Tips for Bulb 
Assembly 

VWR 53507-275  

Stripper Tips:  
70 µm 
100 µm 
150 µm 
200 µm 
275 µm 
600 µm 

 
 
 

Mid Atlantic 

 
MXL3-203-70 
MXL3-203-100 
MXL3-203-150 
MXL3-203-200 
MXL3-203-275 
MXL3-203-600 

 
 

TYGON Application 
Specific Tubing from 
Saint-Gobain 
Performance Plastic 

Fisher Scientific  AAC00006 TYG tub 1/8 IN x 3/16 
IN    
Length: 50ft 
Wall: 1/32 IN 

To make a mouth pipette: 
1) Detach the mouth piece and rubber stopper from the aspirator tube 
2) Cut a piece of TYGON tubing (clear tube) into a 17 inch section 
3) Place the small end of the mouth piece into one open side of the TYGON tube 
4) Into the other end of the 17-inch TYGON tubing, put the tapered, smaller end of the 0.22 um 

MILLEX GP Filter 
5) Around the wider projection on the other side of the 0.22 MILLEX filter, securely place it into one 

open end of the aspirator tube (yellowish in color)  
6) Then take the small, 0.2 um Syringe Filter and insert the tapered smaller end into the other side of the 

aspirator tube 
7) Cut the top bulbous portion off of the rubber bulb and wrap the tight, lipped, non-cut end around the 

wider projection on the other side of the 0.2 um Syringe Filter 
8) To make the glass pipette body, it is necessary to remove the tip.  To do so, wearing a pair of goggles, 

carefully break off the top narrow portion at the point where it widens.  Melt down the sharp edges 
with a Bunsen burner flame. 

9) After cooling, place the melted down end of the glass pipette into the cut end of the rubber bulb 
10) In the other end of the glass pipette place the rubber stopper from the aspirator tube assembly kit, 

tapered side down 
11) Insert the stripper tip into the hole that is in the rubber stopper and pick up cells as needed 
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